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Introduction
 
     This document is an introduction to Maple for Math 2270−3 students who may not have done 
previous work with this software, or who may just want to brush up on their skills.  An on−line version 
of this document is at  http://www.math.utah.edu/~korevaar/2270fall09/2270MapleIntro.mw .  It’s also 
linked from our lecture page. This document was created in Maple 13 (there were 12 previous 
incarnations, with a major change between Maple 8 and Maple 9.)  We may actually use Maple 8 for our
first project on fractals − I need to see if Maple 13 has the same graphing imprecision as did Maple 12.  
As you can see, Maple let’s you create a mixed text−math document.  Although this software has been 
produced by a private company since 1988, it originated with Canadian government support at the 
University of Waterloo; the originators used the leaf on the Canadian flag to motivate the name "Maple."

     You will be using Maple in Math 2270, in order to solve problems and do computer projects.  You 
should think of this software as analgous to the service provided by Microsoft Word as a tool for writing 
papers − except Maple lets you create documents which combine text and mathematics.  Alternately, you
may use Maple to generate mathematical output, which you can then export to other documents.  That is 
closer to how engineers use Matlab, which is more efficient than Maple at doing extremely large 
computations, but lacks Maple’s ability to create text documents and to easily do symbolic mathematical 
work.  Maple 13 exists on our Math computers;  Maple 11 and Maple 8 are on the library computers, and
some version also exists at Engineering.  Maple 8 cannot read Maple 9 and higher documents, unless 
you save in "classic" format.

     When you open any of these Maple versions you can find a "new user’s tour" in a "help" window, and
we recommend you take this tour to get an overview of Maple’s capabilities.  From then on, you will 
learn to use Maple the same way you learned to use Microsoft Word, i.e. by using it, using the help 
features, and asking friends, lab assistants, TAs and teachers when you get stuck. 

Math account name/password exception

     One important exception to the universality of your uid/password for logging on to campus 
computers is the Math Department computer system, http://www.math.utah.edu/ugrad/lab.html.  All 
students taking Math courses are assigned a Math Department login name and initial password that are 
NOT the same as their UID and University password.  The undergraduate walk−in computer lab is 
located in the Rushing Math Student Center, located underneath the plaza connecting JWB to LCB.  
There is also a computer classroom in LCB 115, where some introductory tutorials are held. Useful 
information about most aspects of the lab can be found by following links from the Math Department 
web pages like the one above, or the precurser directory  http://www.math.utah.edu/ugrad .

     If you’re working on the Math Department system your login name will be of the form c−azbc, where
‘az’ is first letter− last letter of your last name, and ‘b’,‘c’ are your first, and middle initials, respectively.  
For example, if your name is Ulysses Attila Eratosthenes, your login name will be c−esua.  (Many people
have the same initials, so to ensure your login name is unique, a digit may be added after the initials, eg. 
c−esua1, c−esua2, ...).  For people with more complex (eg.  hyphenated names) only the first character of 
each name is used.  

     Your initial password will be the letters as in the login name, followed by the last four digits of your 
University ID number (e.g., if your UID is 123456789 and your login name is c−esua, then your 



password is esua6789) or if the login name is c−esua2 the password is still esua6789).  You should
change your password if it’s still the default one. To do so, log in, open a terminal window using a 
mouse or icon selection (depending on the operating system you’ve logged on with), then type ‘‘passwd’’
(followed by RETURN/ENTER).   Ask a lab assistant how to do this if you’re doing this tutorial on 
your own and are confused.  

      If you previously took a math class and used our system, for example if you did "webworks" 
homework, then your old account may still be active, with the last password you used. If all your efforts 
to log on fail, ask a lab assistant for help.  Don’t forget to log out when you’re done.  Never turn off a 
Math Department computer.

Maple

     Maple is partly just a very fancy calculator; it can do practically any undergraduate mathematics 
computation or symbolic manipulation.  You can write programs in Maple and draw pictures as well. 
But you can also use it to create documents which mix text with computations, and you can export 
Maple output to other software to create interesting documents.

     If you are doing a homework assignment you can intersperse text with computations using the 
toolbar:  to get a computation prompt click on the ‘‘[>’’ box near the top.  To insert text click on the ‘‘T’’ 
box.  Or you can change command fields (starting with "[>") into text fields by putting the cursor into 
them and then choosing "T".  You can use the mouse to cut, paste, and edit a document.  You can change
fonts, formats, and use other standard text editing tools by choosing appropriate menu items.  This 
document you are reading is a Maple document even though it is largely text.  You will learn by doing − 
and by asking your neighbor or the lab assistant.

     Under the Help button at the top right of your Maple window you will find the choice "Take a Tour". 
This is a good way to learn generally about what Maple can do.  After making this menu choice Maple 
may hide the beginning of the tour behind other active windows;   use the "Window" menu item to bring
the tour window to the front.   If you wish you can explore now, or you can continue with the Math 2270
notes below and come back to the tour later.  To close the new tour (or any other top window), use the 
‘‘close’’ option inside the ‘‘file’’ menu item.  To keep the tour open but bring another window to the 
front, use ‘‘window’’ menu item.

     Another good introduction to Maple is located at http://www.math.utah.edu/~gardiner/Intro.mws.  (If 
your computer is appropriately configured clicking on this hyperlink will open your browser and go to 
the indicated URL.  You can then save the file to your computer, and then open it from Maple if this 
does not happen automatically.)  Alternately, if you have a browser open, you can open Maple files 
directly off the internet by using clicking successively on  File −> Open URL, in the Maple menu items 
at the top of the Maple window, and pasting or typing the desired URL into the dialog box which 
appears.  (We don’t recommend you use the Explorer browser, it tries to do too much for you and this 
can mess with the Open URL option.)  You can also open the current document using open URL:
 http://www.math.utah.edu/~korevaar/2270fall09/2270MapleIntro.mw

Entering Maple commands: 

     To give you a brief taste of what Maple can do, we will try a few commands.  Move your cursor into 
the "Untitled" (new) Maple window which you created in step (2).  Commands begin on  lines having  a 
command prompt ‘‘>’’, and should be ended with either a semicolon ; or a colon :  If you end with a 
semicolon you will see visible output, if you end with a colon the output will be suppressed even though 
the command is executed.  Maple will not execute a command until you type the ‘‘return’’ or ‘‘enter’’ 



  

  

  

  

  

  

  

  

key.  If you have a multiline command to enter use ‘‘shift−return’’ to change lines without 
executing. 

     If you incorrectly align parentheses or brackets, or do something else which makes your command 
unexecutable you will get a ‘‘syntax error’’ message and Maple will try to point out your mistake with 
the cursor and cryptic diagnostic phrases.  After a while you will become good at fixing these mistakes 
but they can be annoying at first.  Spaces are ignored in Maple, so you may use them to make input 
easier to read.  You can enter explanatory comments in a command line by inserting a ‘‘#’’ to the left of 
the comments; Maple ignores any text after the #.  Sometimes this is more informative then entering 
nearby explanatory text, especially if you are explaining various steps in a subroutine.

    Now, let’s try some commands. (You may try just the math commands, the editorial comments were 
only added to explain what the particular commands are illustrating ! )  Check that you understand what 
each command is doing.

3+4; 4+5: 6 * 7;     #one of these computations will not be 

shown

          #even though all three will be done, illustrating the 

          #difference between a semicolon and a colon

                 

(3+4)7;       #if you want to multiply you must use *, so after

          #trying the command as given, insert a * to fix the

          #resulting syntax error.  You can execute a line or

          #execution group (bracketed on the left) if

          #your cursor is anywhere in it. You can move the

          #cursor with the mouse or the arrow keys. Maple will

          #try to put it in a good place if it detects an error.

(3+4)^2/7; 3+4^2/7; evalf(3+4^2/7);  #the evalf  command gives a

          #decimal approximation instead of an algebraic 

          #expression. Notice that if given a choice, Maple 

          #computes powers first, then multiplies and divides, 

          #and finally adds or subtracts.

diff(x^2,x);  #‘‘differentiate x^2 with respect to x’’

diff(exp(sin(x))*x^3,x);  #a harder differentiation problem

         #you should get output:

f:= x−> exp(sin(x))*x^3;  #this is the syntax for defining a 

         #function, in this case the function we just 

         #differentiated

diff(f(x),x);         #should get the same answer as before.  

int(t^2*exp(t),t);   #‘‘integrate (t^2)*exp(t) with respect

          #to t’’ (Maple doesn’t put in the integration 

constant.)



  

  

  

  

  

  

int(t^3*exp(sin(t)),t);  #this shows that Maple is not God, you 

          #will get

          # since if Maple can’t find an elementary function 

          #antiderivative it just echos what you put in.  

evalf(int(t^3*exp(sin(t)),t=0..1));  #But you could do

          #a definite integral (numerically) even if Maple

          #can’t compute an elementary antiderivative

Pi;exp(1);evalf(Pi);evalf(exp(1));infinity;

          #some important numbers

Downloading Maple documents and creating new ones
    These notes are available online in several formats, if you follow the lectures link from our 2270−3 
home page  http://www.math.utah.edu/~korevaar/2270fall09  .  Files with suffix ".mws" (Maple 8 or 
classic Maple) or ".txt" or ".mw" (Maple 9 and later) can be downloaded from your browser and then 
opened from the appropriate version Maple. 

    With Maple you can create combined text−math documents.  If you’re starting from scratch, open a 
new file using the "File" menu option at the top left of the Maple Window.  Alternately, you can create 
math output and export it to other documents.  This text field was created using the "T" menu item.  To 
do math in a document, move your cursor to just above the place you want to do it, and use the "[>" 
menu item − a math field will be created as near to directly below your current cursor position as 
possible. If you’re in a Math field and want text below it, hit the "T" menu item.

     It is always a good idea to save your maple file periodically.  Save all of your documents − this one, 
which I called 2270MapleIntro.mw (you can change the name if you want), as well as your untitled 
documents. Use the tool bar, using the "save" option under the "File" menu item. The first time you save 
a new file, and any time you use the "save as" option, you will be asked to name your file and say where 
you want to keep it.  You name it in the left part of the box.  Unless you want to save in classic mode (.
mws), Maple will automatically append the suffix .mw; both stand for Maple Work Sheet.  If you’re 
working on a PC, you can use the directory structure to save your file whereever you want.

   If you are on the Math system, your directory is probably new you likely haven’t made any 
subdirectories yet (unix command mkdir, in a local window), but as you create more files you may wish 
to organize where you save them using the tree structure of  Unix directories, which you can follow in 
the right side of your saving box.  You use various UNIX commands in your local or terminal window to
organize your directories.  For more information about this,  go to http://www.math.utah.
edu/computing/unix/unix−commands.html

   It will probably happen some time that you will crash Maple long after your last save.  This will not 
make you feel happy but will teach you an important lesson. 

   Printing depends on the computer or system you are working on, just like for all documents you wish 
to print.

Linear Algebra in Maple



(2)(2)

(1)(1)

  

  

  

  

(3)(3)

  

There are two linear algebra packages in Maple.  The older one is called "linalg", the newer one is called
"LinearAlgebra". At least for now, I’ll use the LinearAlgebra package, since it’s probably easier for you 
to learn those commands and because MapleSoft claims it’s better.  Commands in LinearAlgebra tend to 
be concatenated capitalized words for the complete name of the procedure you wish to do.  You can 
learn about various commands using the Maple help options.

with LinearAlgebra ;  # to see commands, end with ";" to hide them, use ":"
&x, Add, Adjoint, BackwardSubstitute, BandMatrix, Basis, BezoutMatrix, BidiagonalForm,

BilinearForm, CharacteristicMatrix, CharacteristicPolynomial, Column,
ColumnDimension, ColumnOperation, ColumnSpace, CompanionMatrix,
ConditionNumber, ConstantMatrix, ConstantVector, Copy, CreatePermutation,
CrossProduct, DeleteColumn, DeleteRow, Determinant, Diagonal, DiagonalMatrix,
Dimension, Dimensions, DotProduct, EigenConditionNumbers, Eigenvalues, Eigenvectors,
Equal, ForwardSubstitute, FrobeniusForm, GaussianElimination, GenerateEquations,
GenerateMatrix, Generic, GetResultDataType, GetResultShape, GivensRotationMatrix,
GramSchmidt, HankelMatrix, HermiteForm, HermitianTranspose, HessenbergForm,
HilbertMatrix, HouseholderMatrix, IdentityMatrix, IntersectionBasis, IsDefinite,
IsOrthogonal, IsSimilar, IsUnitary, JordanBlockMatrix, JordanForm, KroneckerProduct,
LA_Main, LUDecomposition, LeastSquares, LinearSolve, LyapunovSolve, Map, Map2,
MatrixAdd, MatrixExponential, MatrixFunction, MatrixInverse, MatrixMatrixMultiply,
MatrixNorm, MatrixPower, MatrixScalarMultiply, MatrixVectorMultiply,
MinimalPolynomial, Minor, Modular, Multiply, NoUserValue, Norm, Normalize,
NullSpace, OuterProductMatrix, Permanent, Pivot, PopovForm, QRDecomposition,
RandomMatrix, RandomVector, Rank, RationalCanonicalForm, ReducedRowEchelonForm,
Row, RowDimension, RowOperation, RowSpace, ScalarMatrix, ScalarMultiply,
ScalarVector, SchurForm, SingularValues, SmithForm, StronglyConnectedBlocks,
SubMatrix, SubVector, SumBasis, SylvesterMatrix, SylvesterSolve, ToeplitzMatrix, Trace,
Transpose, TridiagonalForm, UnitVector, VandermondeMatrix, VectorAdd, VectorAngle,
VectorMatrixMultiply, VectorNorm, VectorScalarMultiply, ZeroMatrix, ZeroVector, Zip

A Matrix 3, 4, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12 ;
       # a 3 by 4 matrix, with entries moving left to right, and down the rows
       #  ":=" is how we define things in Maple

A :=

1 2 3 4

5 6 7 8

9 10 11 12

A;

1 2 3 4

5 6 7 8

9 10 11 12

A Matrix 1, 2, 3, 4 , 5, 6, 7, 8 , 9, 10, 11, 12 ;
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       # the same matrix.  You could also use the template on the left menu bar

A :=

1 2 3 4

5 6 7 8

9 10 11 12

ReducedRowEchelonForm A ;

1 0 1 2

0 1 2 3

0 0 0 0

X Vector x 1 , x 2 , x 3 , x 4 ;

X :=

x1

x2

x3

x4

MatrixVectorMultiply A, X ;

x1 2 x2 3 x3 4 x4

5 x1 6 x2 7 x3 8 x4

9 x1 10 x2 11 x3 12 x4


